
МИНИСТЕРСТВО ОБРАЗОВАНИЯ И НАУКИ 

РОССИЙСКОЙ ФЕДЕРАЦИИ 

ФЕДЕРАЛЬНОЕ ГОСУДАРСТВЕННОЕ АВТОНОМНОЕ 

ОБРАЗОВАТЕЛЬНОЕ УЧРЕЖДЕНИЕ ВЫСШЕГО ОБРАЗОВАНИЯ 

«САМАРСКИЙ НАЦИОНАЛЬНЫЙ ИССЛЕДОВАТЕЛЬСКИЙ 

УНИВЕРСИТЕТ ИМЕНИ АКАДЕМИКА С.П. КОРОЛЕВА» 

(САМАРСКИЙ УНИВЕРСИТЕТ) 

 

 

 

 

 

 

 

ЧИСЛЕННОЕ МОДЕЛИРОВАНИЕ РАБОЧИХ ПРОЦЕССОВ В 

ПАРОВЫХ КОМПРЕССОРАХ 

 

Методическое пособие к лабораторной работе 

 

 

 

 

 

 

 

 

 

2017 

 



УДК 533 

ББК 31.31 

Составители: С.С. Корнеев 

Численное моделирование рабочих процессов в паровых компрессорах: 

Методические указания к лабораторной работе / Самарский университет; С.С. 

Корнеев; Самара, 2017. – 22 с. 

Пособие предназначено для студентов, обучающихся по следующим 

направлениям подготовки бакалавра: 13.03.03 – Энергетическое 

машиностроение,  15.03.04 - Автоматизация технологических процессов 

и производств. 15.03.05 - Конструкторско-технологическое обеспечение 

машиностроительных производств, 24.03.05 – Двигатели летательных 

аппаратов; по специальности 24.05.02 – Проектирование авиационных 

двигателей и энергетических установок, по направлению подготовки 

магистров 24.04.05  -  Двигатели летательных аппаратов, а также может 

быть полезно слушателям курсов, аспирантам и специалистам. 

Разработано на кафедре теплотехники и тепловых двигателей. 

 

Печатаются по решению редакционно-издательского совета 

Самарского университета. 

 

  



СОДЕРЖАНИЕ 

1 Схема центробежного парового компрессора ................................................... 4 

2 Методика расчета газодинамических и тепловых процессов в паровом 

компрессоре с использованием программы Ansys Fluent ................................... 6 

 

 

  



1 СХЕМА ЦЕНТРОБЕЖНОГО ПАРОВОГО КОМПРЕССОРА  

Схема центробежного парового компрессора (ЦБПК) представлена на 

рисунке 1. 

 

Рисунок 10.1 – Схема проточной части ЦБПК 

Обозначение контрольных сечений на представленной схеме: 

Н – перед фильтром парокомпрессора; 

В – на входе в парокомпрессор; 

1 – на входе в рабочее колесо; 

2 – на выходе из рабочего колеса; 

3 – на выходе из безлопаточного диффузора; 

г – на входе в отводящий патрубок; 

к – на выходе из парокомпрессора. 



Центробежный паровой компрессор снабжен фильтром 1. В 

рассматриваемой схеме между сечениями В-В и 1-1 установлен неподвижный 

направляющий аппарат (ННА) 2. За РК 3 между сечениями 2-2 и 3-3 

располагается щелевой (безлопаточный) диффузор 3.  

За сечением 4-4 установлен спиральный сборник 4 с отводящим 

патрубком 5, который выполняется в виде конического диффузора. 

Паровой компрессор на расчетном режиме должен иметь: 

 степень повышения давления – к
* = 1,6; 

 расход воздуха – G’ = 0,02 кг/с; 

 диаметр на выходе из РК – D2 =60 мм. 

Значения температуры и давления в соответствии заданными условиями 

принимаются равными Т=333 К и р = 23,0 кПа. 

  



2 МЕТОДИКА РАСЧЕТА ГАЗОДИНАМИЧЕСКИХ И ТЕПЛОВЫХ 

ПРОЦЕССОВ В ПАРОВОМ КОМПРЕССОРЕ С ИСПОЛЬЗОВАНИЕМ 

ПРОГРАММЫ ANSYS FLUENT 

Для расчета газодинамических и тепловых процессов в ПАРОВОМ 

КОМПРЕССОРЕ используется подготовленная сеточная модель. Настройка 

расчетной модели производится в программе ANSYS Fluent. Первым этапом 

производится её запуск с параметрами как на рисунке 2. 

 

Рисунок 2 – Меню запуска ANSYS Fluent 

 

Далее выполнялась настройка параметров сетки (рисунок 3). 

Откройте файл PK.msh:  

File → Read → Mesh... (рисунок 3). 



 

Рисунок 3 – Меню загрузки файла сетки 

 

Программа ANSYS Fluent считает файл и отображает ход чтения в окне 

командной строки. 

Процесс проверки сетки производится следующими командами: 

Mesh → Check 

Процедура проверки выявляет целостность конечных объемов в сеточной 

модели. Убедитесь в том, что наименьший объем отображается со знаком «+». 

Размеры расчетных моделей в программе ANSYS Fluent должны быть 

обязательно заданы в метрах. Построение моделей обычно проводится в 

миллиметрах. Так, как рассматриваемая модель цилиндра была создана в 

миллиметрах, то поэтому построенную сетку нужно уменьшить в 1000 раз. 

Для этого в программе есть удобная команда масштабирования Scale Mesh 

(рисунок 4). Проверка масштабирования сетки осуществляется с помощью 

следующих манипуляций: 

Mesh → Scale... 

 



 

Рисунок 4 – Меню масштаба сетки (Scale Mesh) 

 

Проверьте поле Domain Extents, чтобы убедиться в правильности выбора 

единиц измерения. Главное, чтобы масштаб сетки соответствовал 

проведенным построениям. 

Просмотр конечно-элементной сетки.  

Для того чтобы просмотреть конечно-элементную сетку загруженной 

модели (рисунок 5) необходимо с помощью команды совершить следующие 

действия:  

Display → Mesh... 

 

Рисунок 5 – Меню отображения сетки (Display – Mesh) 



 

Затем необходимо использовать команду Display в окне Mesh Display и 

закрыть данное окно. На рисунке 6 можно увидеть сеточную модель. 

 

Рисунок 6 – Внешний вид расчетной модели 

 

Настройка модели решателя  

Для решения данной задачи выбирается нестационарный метод 

моделирования с учетом турбулентных течений (рисунок 7).  

Выбирается тип задачи – нестационарный:  

Define → General → Solver... 



 

Рисунок 7 – Меню опций решателя (Solver) 

 

Для решения данной задачи рекомендуется использовать настройку 

Pressure Based (в российской литературе его называют алгоритмом 

установления), которая является на сегодняшний день хорошо отработанной и 

эффективной для широкого ряда задач, в том числе и для задач подобного 

рода. 

Для обеспечения высокой точности расчетов необходимо выбрать 

соответствующую для данной задачи модель турбулентности. Учитывая 

сложность задачи, рекомендуется использовать k-ω модель турбулентности 

(рисунок 8). Для этого настройка модели турбулентности вызывается 

следующим образом: 

Define → Models →Viscous... 



 

Рисунок 8 – Меню выбора модели турбулентности (Viscous Model) 

 

При решении данной задачи нужно обязательно учитывать теплообмен и 

теплопередачу. Для этого необходимо подключить к решению уравнение 

энергии с помощью команды:  

Define → Models → Energy... 

 

Рисунок 9 – Меню включения уравнения энергии (Energy) 

 

В появившемся окне нужно поставить галочку в строке Energy Equation и 

нажать ОК (рисунок 9). 

 

 

 



Задание свойств рабочего тела 

Задание свойств рабочего тела осуществляется в меню Create/Edit 

Materials (рисунок 10), которое вызывается командой: 

Define → Materials → air... 

 

Рисунок 10 – Меню настройки свойств веществ (Materials) 

 

В ней выполняются следующие действия: 

В списке свойств Properties в графе плотности Density выбирается 

зависимость для идеального газа ideal-gas. 

Выполнив предыдущий пункт, следует нажать клавишу Change/Create. 

Затем необходимо добавить свойства пара: 

Выбирается база данных Fluent Database в окне Create/Edit Materials. 

Выбирается тип материала в строке Material Type в окне базы данных 

Fluent Database Materials. В данном случае это Fluid (жидкость). 

Выбирается water-vapor из списка жидких материалов Fluent Fluid 

Materials (рисунок 11). 



 

Рисунок 11 – Меню добавления компонентов (Fluent Database Materials) 

 

Следующим действием является операция копирования (Copy). После ее 

выполнения закрывается окно опции Fluent Fluid Materials. 

Настройка граничных условий  

Меню задания граничных условий (рисунок 13) вызывается командой:  

Define → Boundary Conditions... 

В поле Zone находится список всех граничных условий, определенных в 

Meshing. Если выбрать имя одного из них, например, inlet, то в окне Type будет 

указан тип граничного условия. В случае необходимости в этом окне тип 

граничных условий можно поменять.  

Установлены параметры для входного граничного условия (pressure inlet), 

согласно рисунку 13: 

Mass flow rate - 0.02; 

Initial Gauge Pressure -  23000; 

Turbulence Specification Method -  Intensity and Hydraulic Diameter; 

Turbulence Intensity - 5; 



Hydraulic Diameter - 0.041 (диаметр входного сечения).  

Total Temperature  -  333 

 

Рисунок 13 – Настройка граничных условий для входного сечения (inlet) 

 

Затем проводятся настройки параметров выходного сечения (outlet), 

согласно рисунку 14: 

  Gauge Pressure    - 32000; 

  Turbulence Specification Method  - Intensity and Hydraulic Diameter; 

  Backflow Turbulence Intensity  - 10; 

  Hydraulic Diameter - 0.04.  

 Total Temperature -   388. 



 

Рисунок 14 – Настройка граничных условий для выходного сечения (outlet) 

 

Настройка параметров вращающихся лопастей blades осуществляется 

согласно рисунку 15: 

 В опции выбора движения стенки (Wall Motion) устанавливается 

Moving Wall. 

 В опции выбора типа движения стенки выбрается вращательный вид – 

Rotational. 

 Задаются координаты оси (в окне Rotation-Axis Origin установлено X= -

0,005157м;Y=0,000955м; Z= 00 для данной оси, а в окне Rotation-Axis 

Direction для данной оси установлено значение -1 для оси Z), а для 

скорости установлено значение, равное 128000. 



 

Рисунок 15 – Настройка граничных условий для лопаток (blades) 

 

Настройка зон пересечения сетки  

Данная настройка необходима для получения движущейся сетки и на 

этом этапе следует настроить проницаемость границ между расчетными 

зонами (рисунок 16).  

Define → Mesh Interfaces → Create/Edit... 

 

Рисунок 16 – Меню задания проницаемости между зонами (Create/Edit Mesh Interfaces) 



Для этого в данном меню следует выполнить следующую 

последовательность действий:  

В списке Interface Zone 1 выбирается строка interface1.  

В списке Interface Zone 2 выбирается строка interface2.  

В строке Mesh Interface вводится имя in1.  

Затем следует нажать клавишу Create.  

Аналогичным образом задается проницаемость между зонами interface3 

и interface4. 

 

Для выполнения дальнейших действий необходимо сохранить файл 

проекта (PK.cas).  

File → Write → Case... 

Затем следует установить параметры начальных условий для области 

потока с помощью процесса инициализации процесса решения (рисунок 17):  

Solve → Initialization... 

 

Рисунок 17 – Меню инициализации решателя 



Запуск решения задачи  

Для запуска решения задачи следует выбрать следующую команду:  

Solve → Run Calculation... 

В меню Run Calculation (рисунок 18) выполняются следующие действия:  

В строке Number of Iterations выбирается количество итераций, равное 

5000. 

После этого нажатием клавиши Calculate запускается расчет процессов.  

 

Рисунок 18 – Меню запуска выполнения решения (Run Calculation) 

 

Обработка результатов расчета 

На данном этапе следует отобразить контуры статического давления в 

исследуемых местах. Для просмотра полей распределения параметров 

необходимо запустить команду: 

Display → Contours 

В результате ее выполнения появится меню Contours. Чтобы 

распределение параметров отображалось в виде полей, необходимо в окошке 

Filled поставить галочку. В противном случае распределения параметров 

будут изображаться в виде изолиний. Параметр, изменение которого требуется 

отобразить, выбирается в поле Contours of. Оно состоит из двух ниспадающих 



списков. В верхнем выбирается группа, к которой принадлежит нужный 

параметр (например, давление). В нижнем списке уточняется, какой именно 

параметр группы требуется определить (например, статическое давление). Это 

типовая и часто используемая процедура выбора отображаемого параметра в 

программе ANSYS Fluent. 

 

Рисунок 19 – Поля статического давления по сечению 

 



 

Рисунок 20 – Поля статического давления по сечению 

 

 

Рисунок 21 – Поля статического давления по поверхностям 



 

Рисунок 22 – Вектора скоростей в сечении 

 

 

Рисунок 23 – Вектора скоростей в сечении  



ЗАКЛЮЧЕНИЕ  

По результатам выполненной работы можно сделать следующие 

выводы:  

1. Применение CAD/CAE – технологий для моделирования процессов в 

паровом компрессоре позволяет снизить сроки проектирования за счет 

ускорения процесса расчета.  

2. Высокая информативность результатов численного моделирования 

способствует более детально анализировать рабочий процесс ЦБПК.  

3. Моделирование газодинамической структуры потока при 

обоснованном выборе модели турбулентности позволяет с достаточной для 

практики точностью получить распределения основных термодинамических 

параметров внутри парового компрессора.  

 


